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LATEX documents can include many kinds of graphics, ranging from photographs
to illustrations, diagrams and data plots. Oen, the best and simplest choice is to
create the graphic with external soware, and save it in or export it to a LATEX-
compatible format. is article surveys available options.1

1 Introduction

Graphics come in all kinds: photographs, data plots, diagrams, professionally de-
signed illustrations, decorative elements or logos.

File extensions might include .bmp, .png, .eps, .pdf, .emf, .ai and .svg. Extensions
tell something about the structure of a file, but rarely the whole story. Section 2 below
gives some basic background on graphic file formats.

Section 3 reviews soware to create graphics to be used in a LATEX document2.
Besides dedicated graphics soware, this also includes office- and mathematical so-
ware.

One can also manually code or program graphics using a variety of macro pack-
ages and programs, but that is outside the scope of this article.

Finally, Section 4 lists techniques and soware to convert graphic files to suitable
formats.

2 Types of graphics

Graphics can be defined in different ways, depending on the type of information
they contain and on the soware with which they have been created. Figures 1–3
contain some examples, each together with enlarged details.

1e present article is an update of another one published with the same title by the same author in
MAPS no. 35 (2007), pp. 18–26.

2Of course, much of the following also applies to other TEX dialects such as ConTEXt, Texinfo and plain
TEX.



i

i

“eutypon26-27” — 2012/3/7 — 12:49 — page 2 — #6
i

i

i

i

i

i

2 S. Kroonenberg

Figure 1: Bitmapped or raster graphics: above a photograph, below a screenshot, both with an en-

larged detail at the right.

A bitmap or raster graphic is built up as a grid of pixels. Figure 1 shows a photo-
graph and a screenshot. e pixels are obvious in the enlarged detail.

Vector graphics are defined in terms of lines, circles, curves and other geometric
shapes. ey do not pixelate at any scale; see Figure 2.

Some file formats can contain both raster and vector data. In Figure 3, the raster
background becomes blocky when enlarged, but the text on top remains sharp.

2.1 More about bitmaps

2.1.1 Bitmapped file types

Commonfile extensions for bitmaps or raster images include .bmp, .gif, .jpg, .pbm,
.png, .tif and .xpm. ese file types are intended for exchange, i.e., they are not tied
to any particular program.

2.1.2 Compression types

High-resolution bitmapped files can get very large. ere are various ways to
reduce those file sizes.

Lossless compression works by storing information in a more compact way.
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Figure 2: Vector art: a LibreOffice data plot, a drawing adapted from a Ghostscript example file and a

graphic generated with MetaPost.

Here’s a very simplified example: Instead of enumerating a thousand identical white
pixels one by one, you can say at once that the next one thousand pixels are white.
Lossless compression can be quite effective when there are large areas of solid colors
or regular paerns. Png is a lossless bitmapped format that can be processed directly
by pdflatex.

Lossless compression doesn’t work so well with photographic images. When we
no longer insist on exactly preserving every bit of information and accept lossy com-
pression, then very good results can be reached with jpeg. At medium to high quality
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4 S. Kroonenberg

The End
01/04/07 6

he End
Figure 3: Raster and vector combined.

seings, the loss of information is essentially invisible, but the compression rate is
easily 10:1. When you save in jpeg format you can usually make your own tradeoff
between file size and image quality.

For non-photographic bitmapped images such as screenshots or logos, jpeg com-
pression produces visible artifacts; see Figure 4. To be fair, for the right image quality
was set very low in order to make the artifacts more obvious. Here, compression isn’t
all that good either compared to png. Nevertheless, many people use jpeg compres-
sion indiscriminately, even when png would have been much beer.

For the record: Of the above-mentioned raster image formats, .bmp, .pbm and
.xpm are uncompressed; .gif and .png have lossless compression; .jpg lossy compres-
sion; and .tif may have any type of compression, or none at all.

Although .gif is compressed in a lossless way, it cannot contain full-color images,
only images with a palee of up to 256 colors. For photographic images, this color
reduction can do much more damage to the end result than lossy compression.

Figure 4: Don’t use jpeg compression for screenshots.
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External graphics for LATEX 5

2.1.3 Bitmap resolutions

e resolution of a bitmap should be high enough to look sharp, but, in order to
keep file size and loading times within bounds, the resolution should not be higher
than necessary.

For screen viewing, the ideal resolution would be exactly one bitmap pixel per
screen pixel, but of course you may not know at what screen resolution and zoom
level your document will be viewed.

For printing, good resolutions are:

Photographs 150–300 dpi (dots per inch) depending on the output device. Most
printers and imageseers simulate grays and other tints with dot paerns or halone
screens. As a consequence, the effective printed resolution of a photograph is much
lower than the resolution of the output device, no maer how high the resolution of
the original photograph.

Charts and diagrams 600–1200 dpi. A 600 dpi resolution is enough to avoid visible
blockiness. Higher resolutions can mean finer detail, if the printer resolution is also
high. But vector formats are beer for such graphics.

Screenshots Keep the original resolution.

Of course I am talking about resolution aer scaling; if you print a 2 in wide, 300 dpi
image at a width of 4 in, then the effective resolution is 150 dpi.

It will do no good to increase the resolution of an existing low-resolution image;
it might even make the output fuzzier. So either try to get a beer original, or use
your bad picture as-is.

2.2 More about vector graphics

2.2.1 Eps and pdf

e two vector formats that maer here are eps (Encapsulated PostScript) and
pdf. Pdf is an offshoot of PostScript. ere are many similarities between the two
formats, and it is oen possible to convert a file from one format to the other and
back again without real loss of information; see Section 4.2. Svg is another related
format, but is currently not well-supported by TEX.

ese formats can contain vector objects, text and also bitmaps, all in the same
file; see for example Figure 3.

2.2.2 Problems with vector graphics

Missing fonts If some standard fonts (Times, Helvetica, Courier, Symbol, Zapf
Dingbat) are not embedded, then epspdk (Section 4.2) can help. If the pdf output
target is set to prepress then fonts will be embedded during conversion to pdf. Eps-
pdk can convert back and forth between eps and PostScript on the one hand and
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6 S. Kroonenberg

pdf on the other. You can either apply a pdf-to-eps-to-pdf conversion to individual
graphics or a pdf-to-ps-to-pdf conversion to the document as a whole.

If other fonts are missing then you have a real problem.

Zero-width lines If your graphic has some very thin lines, then check by zooming
inwhether the lines have some positivewidth. A linewidth of zerowill be interpreted
by the output device as a width of one pixel, which is fine for the screen or for an
old 300 dpi laserprinter, but not for a 2400 dpi imageseer. A line width of e.g., 0.3 pt
should be safe. You may be able to fix this from within the program with which the
graphic was created.

Transparency and fill patterns Many programs and graphic formats do not support
transparancy or fill paerns; upon conversion these features might either get lost
altogether or simulated with e.g., bitmaps, which might make the file much larger
and virtually uneditable. Hang on to the original—which you should do in any case.

2.2.3 General fixes

You may be able to import the file in a draw program and fix problems there:
substituting fonts, changing line widths, replacing paern fills with something else;
see Section 3 on draw programs.

If the amount of text is small, e.g., just a logo, consider converting the text to
curves, i.e., characters are replaced by their shapes, losing the reference to the font.

As a last resort, you can convert your graphic to a bitmapped png file of suffi-
ciently high resolution.

2.3 Proprietary formats

Graphics editors can also have their own native format, e.g., .psd for PhotoShop,
.cdr for CorelDRAW or .xcf for the GIMP.ese formats support additional structure,
which makes them beer for editing, at least with the original graphics editor. Even
if you save in a LATEX-compatible format, youmaywant to preserve the native version
as well for future editing. is is especially true for vector graphics.

Another trend is to store private information for future editing in a hidden stream
in the exported file. e svg, eps and pdf formats can contain such hidden streams,
and various programs use that fact. is private information may not be readable by
another graphics editor, but a program such as LATEX that only needs to render the
file can simply ignore it.

3 Creating graphics

In computer graphics, the term drawingmeans making vector pictures and paint-
ing means making bitmapped pictures.
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External graphics for LATEX 7

Figure 5: Inkscape, a free vector draw program for Linux, Windows and Mac OS X.

You should be able to use any eps, pdf or bitmapped graphicwith LATEX and deriva-
tives3, although sometimes conversion may be needed; see Section 4 for details. e
only real concern is geing vector graphics intact into eps- or pdf format.

3.1 Drawings and diagrams

You can create drawings and diagrams in Word or PowerPoint. However, it may
be difficult to export graphics from these programs intact to eps or pdf, the formats
needed by LATEX and derivatives4. Instead, check out some free alternatives. Inkscape
is a specialized draw program resembling CorelDRAW and Illustrator. It uses svg as
its native format and can export to pdf. Or try the Drawmodule of LibreOffice/Open-
Office.org. is MS Office alternative is fairly good at reading and writing MS Office
files, and has a pdf export option.

If you spend a lot of time creating and editing vector graphics, and especially

3To be precise, the term ‘derivative’ applies to the underlying TEX engine (pdex, xetex, luatex), not to
the LATEX macro package on top of it.

4Although the LATEX derivatives can also use the bitmapped jpeg and png file formats, we would rather
not convert vector graphics to bitmaps.
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8 S. Kroonenberg

ℵ

Regular text

Figure 6: Text and math as shown by TpX and as rendered by the parent document.

if you also need to ready your documents for professional printing, consider buy-
ing a professional draw program such as CorelDRAW or Illustrator, part of Adobe’s
Creative Suite.

Under Mac OS X there are several inexpensive commercial programs worth
checking out. Since OS X supports pdf natively, geing a good pdf from your graphic
is rarely a problem, even from cheap or office-centric graphics programs.

In any case, investigate at an early stage how to get your drawings into LATEX; see
Section 4.

3.2 Draw programs with LATEX support

LATEX-oriented draw programs include Ipe (cross-platform) and TpX (Windows-
only). TpX is also available from CTAN, e Comprehensive TEX Archive Network.
Both are free.

Ipe renders text and formulas itself, using LATEX. You can tune the output via
preamble commands (Edit > Document properties).

TpX normally leaves the rendering of text and math to the parent document:
when saving, it creates three files: an eps- and a pdf file with everything which is
not text or math, and a LATEX file with extension .tpx which typesets text and math
and loads either the eps or the pdf. is TpX file has to be \input-ed into the parent
document.

is way, text and math in the drawing are automatically in step with the docu-
ment; see Figure 6.

TpX has additional export options; see its documentation.

3.2.1 LATEX support in Inkscape

Inkscape, already mentioned in Section 3.1, also offers some forms of LATEX sup-
port:

• If Inkscape finds LATEX and some auxiliary programs (Ghostscript, pstoedit), it
may offer support for LATEX objects: Extensions > Render > LATEX formula; see
Figure 7.

• If you want editable LATEX objects, you can try whether the textext exten-
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Figure 7: Entering a LATEX equation in Inkscape.

sion (url http://pav.iki.fi/software/textext/, menu item Extensions >
Tex Text) works for you.

• If you save an Inkscape drawing to pdf, one of the export options is
‘PDF+LaTeX: Omit text in PDF, and create LaTeX file’.is appears to apply only
to regular text.

3.3 Charts

Charts are normally generated as a byproduct of spreadsheets or mathematical
soware. Mathematical and statistical programs oen have eps or pdf export op-
tions, and sometimes also have support for LATEX text labels. As to spreadsheets, see
Section 3.1.

3.4 Bitmaps: paint programs and image editors

ere exists a large selection of free and inexpensive paint programs and image
editors. As to pre-installed programs: Windows already includes Paint, a very ba-
sic bitmap editor, which, however, can read and write a variety of formats, and can
also crop images. Mac OS X includes Preview. Besides reading pdf documents, this
program can also read, convert and crop5 images.

3.5 Screenshots

You can take screenshots without specialized soware:

3.5.1 Windows

e PrtScrn key will copy the entire screen to the clipboard, and Alt-PrtScrn the
active window. Most paint- and image-editing programs can retrieve the screenshot
from the clipboard, usually with Edit/Paste. ey also have tools to crop images.

5Indirectly, via ‘New from clipboard’.
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10 S. Kroonenberg

Figure 8: Bitmap2eps, a right-click item to convert a bitmap to eps format.

3.5.2 Mac OS X

Cmd-Shi-3 copies the entire screen to a file on your desktop, and Cmd-Shi-4
lets you make a selection.

3.5.3 Linux

Here, depending on your chosen desktop and configuration, PrtScrnwill probably
take a screenshot as well, either to the clipboard or to a file. I usually take screenshots
with the GIMP (File > Acquire > Screenshot).

4 Converting to compatible formats

e LATEX derivatives pdflatex, xelatex and lualatex all can use the bitmapped for-
mats png and jpeg directly as graphics formats.

For vector graphics, you can use either pdf or eps, although eps requires a conver-
sion6, and this may have been disabled for security reasons. If on-the-fly conversion
is not available, you can still convert in a separate step; see Section 4.2.

For the LATEX plus dvips route, you are restricted to eps format. If at all possible,
use one of the LATEX alternatives.

4.1 Converting bitmaps to png, jpg and eps

Almost any image editor and paint program can convert to png and jpg. is is
all you need unless you have to use LATEX itself and need eps format. More advanced
programs can export to eps (and to pd).

ForWindows Explorer, TEX Live 2011 adds a right-click menu item bitmap2eps to
bitmapped formats for conversion to eps; see Figure 8. It makes use of the command-
line converter sam2p, with bmeps as a fallback. MikTeX users can run bmeps from
the command-line.

6In the case of pdflatex and lualatex, the eps is converted to a file filename-eps-converted-to.pdf,
in the case of xelatex the converted code is wrien directly to the pdf output of the document without
creation of an intermediate file.
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External graphics for LATEX 11

On Unix-based systems the obvious choice for a command-line converter is con-
vert:

convert filename.png filename.eps

Convert is packaged for most Linux distributions as part of Imagemagick. Convert
itself is included in MacTEX.

4.2 Converting between PostScript, eps and pdf

4.2.1 epstopdf

Epstopdf is the program used for on-the-fly conversion from eps to pdf. It is part
of most TEX distributions and is probably already on your system. Epstopdf uses
Ghostscript, either a standalone version or the version built into the TEX distribution.

4.2.2 Epspdf and epspdk

Epspdf can convert back and forth between PostScript, eps and pdf, in many
cases with no loss of information. It can also remove unwanted borders (compute
tight boundingbox option) and convert some color graphics to grayscale. It uses
Ghostscript and optionally pdops from the Xpdf suite.

Epspdk is a GUI program, using epspdf in the background.
A LATEX package epspdfconversion substitutes epspdf for epstopdf for on-the-fly

conversion to pdf. Note that it needs shell-escape to be fully enabled; see the package
documentation.

4.2.3 Convert

Onmany systems, convert from the Imagemagick suite will use Ghostscript when
converting between eps and pdf, and will in that case convert vector graphics to
vector graphics. Prefix the target pdf filename with EPDF: if you want to preserve
the eps boundingbox. View the result at a high zoom level to make sure that it is
indeed still a vector graphic.

4.2.4 Ghostscript and pdops

You can also use Ghostscript directly for converting eps and PostScript to pdf, and
either Ghostscript or pdops from the Xpdf suite for converting in the other direc-
tion. Ghostscript includes various scripts/batchfiles to facilitate these conversions.
But this is not the place for explaining the use of these programs.

4.3 Exporting eps and PostScript from Windows programs

If a Windows program does not have a usable export option, then you can try to
‘print’ to a PostScript file.

For this, you need to have a PostScript printer driver. If you don’t have one in-
stalled, go to ‘Printers’ and start up the Add Printer wizard. Choose Local Printer
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Figure 9: Configuring a PostScript printer driver.

and uncheck automatic detection. As printer port, you can pick FILE, otherwise you
would have to manually check ‘Print to File’ anytime you print. A good choice for
manufacturer and model would be ‘Generic’ and ‘MS Publisher Imageseer’ respec-
tively.

Pay aention to printer seings (Figure 9): in the Print dialog, click ‘Properties’,
then ‘Advanced’ (on either tab). In the ‘Advanced Document Seings’ tree, under
‘Graphic’, ‘TrueType Font’ should be set to ‘Download as Sofont’7.

Now navigate to first ‘Document Options’, then ‘PostScript Options’. For
‘PostScript Output Option’ the default seing is ‘Optimize for speed’. Change that
to ‘Optimize for Portability’ or ‘Archive Format’, or, for single pages only, ‘Encapsu-
lated PostScript’. ese non-default options presumably produce cleaner PostScript
code, without printer-specific hacks. Experiment with this and other options if you
run into problems (e.g., bad-looking screen output, or part of a graphic geing cut
off, or conversion to bitmap).

Next, the seing ‘TrueType Font Downloading Option’ should be set to ‘Outline’,
not ‘Automatic’ or ‘Bitmap’.

Useful links

CTAN, e Comprehensive TEX Archive Network. URL: http://mirror.ctan.org/.

Epspdf and epspdk. Available from CTAN. URL: http://tex.aanhet.net/epspdf/.

7e alternative seing is ‘Substitute with Device Font’. For prepress use, you should always include
all fonts. It is possible to include fonts aer the fact, when converting to pdf, but then you run the risk of
noticeable discrepancies between the original font and the actually included font.
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Ghostscript. Free PostScript interpreter. URL: http://ghostscript.com/.

ImageMagick. For converting andmanipulating images. URL: http://imagemagick.
org/.

Inkscape. Draw program. URL: http://inkscape.org/.

Ipe. Draw program with LATEX support. URL: http://sourceforge.net/projects/
ipe7/.

LibreOffice. Office suite. URL: http://www.libreoffice.org/.

MacTEX. TEX Live for Mac OS. URL: http://www.tug.org/mactex/.

TpX. Draw program with LATEX support; available from CTAN. URL: http://
sourceforge.net/projects/tpx/.

Xpdf. Pdf viewer and utilities. URL: http://www.foolabs.com/xpdf/.


